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Weitere Informationen, Updates oder Software 
Besuchen Sie unsere Webseite über folgenden QR-Code oder Weblink. Hier finden Sie 
zusätzliche Informationen, verfügbare Updates oder Software zu diesem Produkt sowie 
passendes Zubehör. 

3D-Drucker 

 
www.bresser.de/P2010600 

Zubehör 

 
www.bresser.de/P2080210000000 

 

After Sales Support / Service 
Für dieses Produkt bieten wir einen individuellen Service auch über den Kauf hinaus. Sollten 
Sie Probleme mit diesem Produkt haben, hilft Ihnen unser Kundenservice gern weiter. 

Für eine reibungslose Abwicklung halten Sie bitte die folgenden Informationen für 
eventuelle Nachfragen bereit: 

 Garantie/Service-Karte 
 Artikelnummer und Produktbeschreibung 
 Kaufdatum und Händler 

 
Kontaktmöglichkeiten: 
 
e-Mail:  service.3d@bresser.de   (bevorzugter Kommunikationsweg) 
Internet:  www.bresser.de/c/de/service 
Telefon*:  0 28 72 - 80 74-210 

Servicezeiten: 

Montag bis Freitag   9:00 bis 15:00 Uhr (MEZ) 
(außer an nationalen Feiertagen) 

* Lokale Rufnummer im dt. Festnetz / Gebühren je Anruf abhängig vom Tarif Ihres Telefonanbieters / Anrufe aus dem Mobilfunknetz und dem 
Ausland ggf. wesentlich teurer 

 

Garantie 
Informationen dazu entnehmen Sie bitte der 
beiliegenden Karte „Garantie & Service“.  
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Einleitung 
 

Hinweis: Jedes Gerät wird vor dem Versand einem Werkstest unterzogen. 
Rückstände am Extruder oder kleinste Kratzer auf dem Konstruktionsband sind 
normal und haben keinen Einfluss auf die Druckqualität. 

Bresser GmbH möchte diese Bedienungsanleitung zum Anlass nehmen, sowohl den 
Technikern von Bresser GmbH, als auch den Benutzern dieses 3D-Druckers für 
ihren unermüdlichen Einsatz und die überaus wichtige Unterstützung zu danken. 

Diese Bresser GmbH Bedienungsanleitung richtet sich an die Nutzer von T-REX 2, 
die nun Ihre Reise in die Zukunft des Drucks mit Bresser GmbH T-REX 2 antreten. 
Selbst wenn Sie mit älteren Modellen der Bresser GmbH-Geräte oder der 3D-
Drucktechnologie vertraut sind, empfehlen wir Ihnen, diese Anleitung zu lesen. Sie 
enthält viele wichtige Informationen für Sie zum T-REX 2 und für die Verbesserung 
der 3D-Erfahrung.: 

(1) BRESSER T-REX 2 Schnellstartanleitung 

Die Schnellstartanleitung ist im Lieferumfang des Druckers enthalten. Mithilfe der 
darin enthaltenen Informationen können Sie in kürzester Zeit mit dem Drucken 
beginnen. 

(2) BRESSER SAURUS Produktseite im Internet     

Auf der Produktseite im Internet unter www.bresser.de/P2010600 finden Sie 
zusätzliche Informationen, verfügbare Updates oder Software zu diesem Drucker, 
sowie zu passendem Zubehör.  
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Allgemeine Informationen 
 

Wichtige Hineise: 
- Lesen Sie diese Bedienungsanleitung vor der Benutzung des Geräts aufmerksam 

durch. 
- Die Bedienungsanleitung setzt die Verwendung des Betriebssystems Windows 7 

für den Betrieb des 3D-Druckers voraus.  
- Es wird die aktuelle Version der REXprint-Software verwendet. 

In dieser Bedienungsanleitung sind alle Informationen enthalten, die für die 
Einrichtung und den Betrieb des Geräts erforderlich sind. 

Die Bedienungsanleitung setzt sich aus den folgenden Teilen zusammen: Einleitung, 
Allgemeine und Sicherheitsinformationen, Bedienung und Produktservice. 

 

Bei Service-Anfragen bitte bereithalten: 

Artikelnr.: 2010600 
Produktbez.: BRESSER T-REX 2 WLAN 3D Drucker 
Bedienungsanleitung: 
Manual_2010600_Wifi-3D-Printer-T-REX-2_de_BRESSER_v032021a.docx 
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Sicherheitshinweise 
HINWEIS! 

Machen Sie sich mit diesem Handbuch vertraut und lesen Sie alle enthaltenen 
Anweisungen, bevor Sie mit der Einrichtung und dem Betrieb des Geräts beginnen. 
Wenn Warnungen und Anweisungen nicht berücksichtigt werden, kann dies zu 
Verletzungen von Personen, zu Feuer, sowie zu einer Beschädigung des Geräts 
oder anderer Gegenstände führen. 

BEFOLGEN SIE ZU JEDER ZEIT STRIKT ALLE IN DESEM HANDBUCH 
AUFGEFÜHRTEN SICHERHEITS- UND SONSTIGEN HINWEISE! 

Sicherheit in der Arbeitsumgebung 
① Halten Sie den Arbeitsplatz sauber! 

② Betreiben Sie den 3D-Drucker nicht, wenn brennbare Flüssigkeiten, Gase 
oder Staub vorhanden sind. 

③ Halten Sie Kinder und ungeschulte Personen vom 3D-Drucker fern. 
 

Sicherheit bei der Stromversorgung 

① Betreiben Sie den 3D-Drucker nur über eine geerdete Steckdose. Nehmen Sie 
keine Veränderungen am Netzstecker des 3D-Druckers vor. 

② Betreiben Sie den 3D-Drucker nicht in dunstiger oder feuchter Umgebung. 
Setzen Sie den 3D-Drucker keiner direkten Sonneneinstrahlung aus. 

③ Nutzen Sie das Netzkabel nicht für einen anderen als den vorgesehenen 
Zweck. 

④ Betreiben Sie das Gerät nicht während eines Gewitters. 

⑤ Um Unfälle zu vermeiden, trennen Sie das Gerät von der Stromversorgung, 
falls Sie es für einen längeren Zeitraum nicht benutzen. 

 

Sicherheit von Personen 

① Berühren Sie während des Druckens nicht die Düse oder die Druckplatte. 

② Berühren Sie die Düse nach Abschluss des Druckvorgangs nicht. 

③ Tragen Sie geeignete Kleidung. Tragen Sie keine weite Kleidung oder locker 
sitzenden Schmuck. Achten Sie darauf, dass Sie mit Ihren Haaren, der Kleidung 
und Handschuhen nicht in die Nähe der beweglichen Teile kommen. 
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④ Betreiben Sie das Gerät nicht, wenn Sie müde sind oder unter dem Einfluss von 
Drogen, Alkohol oder Medikamenten stehen. 

 

Vorsichtsmaßnahmen 

① Lassen Sie das Gerät nicht für längere Zeit unbeaufsichtigt. 

② Nehmen Sie keine Veränderungen am Gerät vor. 

③ Senken Sie die Druckplatte ab, bevor Sie Filament einsetzen/entnehmen. (Der 
Abstand zwischen Düse und Druckplatte sollte mindestens 50 mm betragen.) 

④ Betreiben Sie das Gerät in einer gut belüfteten Umgebung. 

⑤ Nutzen Sie das Gerät nicht für unrechtmäßige Zwecke. 

⑥ Nutzen Sie das Gerät nicht, um Behälter zur Aufbewahrung von Lebensmitteln 
herzustellen. 

⑦ Nutzen Sie das Gerät nicht, um elektrische Geräte herzustellen. 

⑧ Nehmen Sie Modelle nicht in den Mund. 

⑨ Entnehmen Sie die Modelle nicht mit Kraftanwendung. 

  

Umgebungsbedingungen 

Temperatur: Raumtemperatur 15-30°C 
Feuchtigkeit: 20 %-70 % 

 

Filament-Vorgaben 

Filament nur für den vorgesehenen Zweck nutzen! Nur das BRESSER Filament oder 
Filament der von BRESSER anerkannten Marken verwenden! 

Filament-Aufbewahrung 

Bei allen Polymeren lässt sich im Lauf der Zeit ein gewisser Zerfall feststellen. 
Packen Sie das Filament erst dann aus, wenn Sie es benötigen. Das Filament sollte 
in einer sauberen und trockenen Umgebung und vor Sonneneinstrahlung geschützt 
aufbewahrt werden. 

 

Rechtlicher Hinweis 

Alle Informationen in diesem Dokument können ohne vorherige Ankündigung 
erweitert oder angepasst werden. 
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DIE BRESSER GMBH ÜBERNIMMT KEINE GEWÄHRLEISTUNG IM HINBLICK 
AUF DIESES DOKUMENT, EINSCHLIESSLICH, JEDOCH OHNE 
BESCHRÄNKUNG AUF DIE IMPLIZIERTE GEWÄHRLEISTUNG DER 
MARKTFÄHIGKEIT UND EIGNUNG FÜR EINEN BESTIMMTEN ZWECK. 

Die BRESSER GmbH übernimmt ferner keine Haftung für in diesem Handbuch 
enthaltene Fehler, für zufällige Folgeschäden in Verbindung mit der Lieferung, der 
Leistung oder der Verwendung dieses Materials. 

 

EG-KONFORMITÄTSERKLÄRUNG  
Eine „Konformitätserklärung“ in Übereinstimmung mit den anwendbaren 
Richtlinien und entsprechenden Normen ist von der Bresser GmbH erstellt 
worden. Der vollständige Text der EG-Konformitätserklärung ist unter der 

folgenden Internetadresse verfügbar: 

www.bresser.de/download/2010500/CE/2010500_CE.pdf 

 

UK-KONFORMITÄTSERKLÄRUNG  
Eine „Konformitätserklärung“ in Übereinstimmung mit den anwendbaren 
Richtlinien und entsprechenden Normen ist von der Bresser GmbH erstellt 
worden. Der vollständige Text der UKCA-Konformitätserklärung ist unter der 

folgenden Internetadresse verfügbar: 

www.bresser.de/download/2010500/UKCA/2010500_UKCA.pdf 

 

http://www.bresser.de/download/2010500/CE/2010500_CE.pdf
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Dieses Dokument enthält durch Urheberrechte geschützte Informationen. 

Copyright © 2020 BRESSER GmbH. Alle Rechte vorbehalten.  

Die Reproduktion dieser Dokumentation – auch auszugsweise – in irgendeiner Form 
(z.B. Fotokopie, Druck, etc.) sowie die Verwendung und Verbreitung mittels 
elektronischer Systeme (z.B. Bilddatei, Website, etc.) ohne eine vorherige schriftliche 
Genehmigung der BRESSER GmbH ist nicht gestattet. 

Die in dieser Dokumentation verwendeten Bezeichnungen und Markennamen der 
jeweiligen Firmen sind im Allgemeinen in Deutschland, der Europäischen Union 
und/oder weiteren Ländern waren-, marken- und/oder patentrechtlich geschützt. 
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Kapitel 1: 3D- Drucktechnologie 
 

Beim 3D-Druck werden dreidimensionale Modelle in physische Objekte verwandelt, 
die Sie berühren und in die Hand nehmen können. Diese Druckform wird auch als 
additive Herstellung bezeichnet, da das 3D-Modell erstellt wird, indem so viele 
Schichten aufgetragen werden, bis das Objekt vollständig geformt ist. 

Die Schmelzschichtung (Fused Filament Fabrication, FFF) ist die häufigste Methode 
des 3D-Drucks, die auch von diesem 3D-Drucker eingesetzt wird. Bei dieser 
Druckmethode wird ein Kunststoff, das Filament, bei hoher Temperatur geschmolzen 
und auf eine Druckoberfläche aufgebracht. Das Filament verfestigt sich während des 
Abkühlens, also praktisch unmittelbar nach dem Austritt aus der Düse. 3D-Objekte 
werden dadurch geformt, dass das Filament in mehreren Schichten übereinander 
aufgetragen wird. 

1.1 Verfahren 
Der 3D-Druck umfasst drei Schritte:  

1. Erstellen oder Herunterladen eines 3D-Modells  
2. In Scheiben Schneiden und Exportieren des 3D-Modells 
3. Aufbauen des 3D-Modells 

1.1.1 Erstellen eines 3D-Modells:  

Derzeit bestehen drei Möglichkeiten zum Erstellen eines 3D-Modells: 

- Von Grund auf Entwerfen Sie können kostenfreie CAD-Software (Computer-
Aided Design) wie beispielsweise 3DTADA, AutoCAD, SolidWorks, Pro-E oder 
unsere eigene Software Happy 3D nutzen, um ein eigenes 3D-Modell zu 
entwerfen.  

- 3D-Scanner Alternativ zum Erstellen eines 3D-Modells können Sie auch ein Objekt 
scannen. Ein 3D-Scanner digitalisiert ein physisches Objekt, indem er die 
geometrischen Daten des Objekts erfasst und in einer Datei auf dem Computer 
speichert. Es besteht auch die Möglichkeit, ein Mobilgerät mithilfe einer App als 
3D-Scanner zu verwenden. 

- Aus der Cloud Die derzeit am weitesten verbreite Methode zum Beschaffen eines 
3D-Modells besteht darin, ein 3D-Modell von einer Website herunterzuladen, auf 
die Benutzer ihre eigenen 3D-Modelle hochladen können.  

cloud.sz3dp.com   Bresser GmbH Cloud 

www.thingiverse.com Thingiverse ist eine aktive Community zum Entdecken, 
Herstellen und Weitergeben von 3D-Modellen. 
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1.1.2 Slicing und Export eines 3D-Modells: 
Mit einer Slicer-Software werden 3D-Modelle für den Druck vorbereitet und in 
Anweisungen für den 3D-Drucker umgewandelt. REXprint ist die Slicer-Software für 
diesen 3D-Drucker. Mit REXprint können STL-Dateien in G- oder GX-Dateien für den 
Druck umgewandelt werden. Mittels USB-Kabel, USB-Stick oder per W-LAN werden 
diese dann zum 3D-Drucker übertragen. 

1.1.3 Aufbau des 3D-Modells 
Nachdem die Ausgabedatei an den 3D-Drucker übertragen wurde, beginnt dieser 
damit, das 3D-Modell in ein physisches Objekt zu übertragen, indem er Schichten 
von Filament übereinander aufträgt. 
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Kapitel 2: Informationen zum 3D Drucker 
2.1 Informationen zum 3D-Drucker 
2.1.1 Teileübersicht 

 
 

1. Plattform 
2. Plattformstütze 
3. Nivelliermutter 
4. LCD-Anzeige 
5. Z-Achsenführungsstab 
6. Extruderkabelsatz 
7. X-Achsenführungsstab 
8. Schlitz 

9. Düsenkühlgebläse 
10.  Federniederhalter 
11. Kühlgebläse 
12. Düse 
13. Turbogebläseplatte 
14. Extruderhalterung 
15. SD-Kartenschlitz 
16. USB-Eingang 

17. Filament-
Führungsrohrspangen 

18. Spulenhalterschlitz 
19. Spulenhalter 
20. Netzeingang 
21. Netzschalter
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2.1.2 Zubehör 
 

     
3D-Drucker Filamentspule Obere Abdeckung Service-Karte Schnellstart-

anleitung 

     
Stromkabel USB-Kabel SD-Karte Spulenhalter Build Tape 

     
Schraubendreher Stempelschlüssel Inbusschlüssel Stiftwerkzeug Schaber 

     
PTFE-Schlauch Führungsrohr Schmierfett Klebestift Feuchtigkeitsab-

weisende Platte 

  

   

Nivellierungs 
-karte 

Nivelliermutter    
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2.1.3 Begriffe 
 

Konstruktionsplatte Die Oberfläche, auf der BRESSER T-REX 2 ein 
Objekt aufbaut. 

Bauvolumen Die dreidimensionale Fläche eines Objektes nach 
seiner Fertigstellung. Größtes Bauvolumen von 
BRESSER T-REX 2: 200x148x150 mm. 

Nivelliermuttern Mithilfe der Muttern unter der Plattform wird die 
Distanz zwischen Düse und Konstruktionsplattform 
angepasst. 

Extruder Der Extruder zieht das Filament von der Spule, 
schmilzt es und drückt es durch eine Düse auf die 
Konstruktionsplattform. 

Düse Dieser „Druckkopf“ sitzt am Boden des Extruders, 
dort 
wo das erwärmte Filament herausgedrückt wird. 

Filamentführungsrohr Ein Plastikrohr, in dem das Filament von der 
Filamentbox zur Filamentaufnahme geführt wird. 

Stanzschlüssel Ein Werkzeug für die Festlegung der Größe des 
Düsenmetallwürfels. 

Reinigungsstiftwerkzeug Ein Werkzeug für die Reinigung des verstopften 
Extruders. 
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2.1.4 Gerätedaten 
 

Name BRESSER T-REX 2 WLAN 3D Drucker 

Anzahl der Extruder 2 (unabhängig) 

Drucktechnologie Schmelzschichtung (Fused Filament Fabrication, 
FFF) 

Displaygröße 8,9 cm (3,5“)s 

Druckvolumen 200 x 148 x 150 mm 
Spiegelmodus: 80 x 148 x 150 mm 
Duplizierungsmodus: 95 x 148 x 150 mm 

Schichtauflösung 0,1 – 0,4 mm 

Druckgenauigkeit ±0,2 mm 

Druck Filament PLA/PVA/ABS/HIPS 

Filamentdurchmesser 1,75 mm 

Düsendurchmesser 0,4 mm 

Software REXprint 

Unterstütztes Dateiformate Eingabe: 
3MF/STL/OBJ/FPP/BMP/PNG/JPG/JPEG 
Ausgabe: 
GX/G 

Wechselstrom-
Eingangsspannung 

Eingang: 100-240 VAC, 47-63 Hz; Leistung: 320 W 

Anschlüsse SD-Karte, USB-Kabel, Bresser GmbH Cloud 

Betriebssystem Windows XP/Vista/7/8/10, Mac OS, Linux 

Geräteabmessungen 526 x 360 x 403 mm 

Nettogewicht 15 kg 
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2.2 Auspacken und Installation 
2.2.1 Auspacken 
In diesem Kapitel wird beschrieben, wie Sie den 3D-Drucker vollständig auspacken.  

Hinweis:  
Lesen Sie den Leitfaden zum Auspacken bitte vollständig durch. 

1. Entfernen Sie die Verpackung und nehmen Sie den Inhalt 
vorsichtig heraus. Wenden Sie keine Kraft auf. 

2. Das gelbe hochtemperaturfeste Klebeband um die Düse 
nicht entfernen. Es weist thermische Isolations- und 
hochtemperaturfeste Eigenschaften auf. 

 

  

① Öffnen Sie den Karton und nehmen 
Sie die Schaumstoffteile heraus. 

② Halten Sie beide Griffe an den 
beiden Seiten des Druckers fest. 
Heben Sie ihn aus dem Karton und 
stellen Sie ihn auf einer stabilen 
Oberfläche ab. 
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③ Entfernen Sie den Packbeutel und 
entfernen Sie das Band sowie die 
Kunststoff-Schutzumhüllung der 
Frontklappe. 

④ Das Zubehör ist hier dargestellt. 
Entfernen Sie die Innenverpackung 
und nehmen Sie das Zubehör 
vorsichtig heraus. 

  

⑤ Nehmen Sie den Extruder heraus 
und stellen Sie ihn vorsichtig auf. Die 
Düse darf den Tisch nicht berühren, 
damit die Düse vor Kratzern 
geschützt bleibt 

⑥ Nehmen Sie den Schaumstoff mit 
dem Zubehör heraus. Schneiden Sie 
die beiden Kabelbinder an beiden 
Seiten des X-Achse-Führungsstabs 
durch. 

  

⑦ Öffnen Sie die Klappe, nehmen Sie 
die obere Abdeckung des Druckers 
heraus und lösen Sie das Filament 
aus dem Deckel. 

⑧ Halten Sie beide Seiten der 
Druckplattform fest und heben Sie 
die Plattform vom Boden, damit sich 
die Schaumstoffbox darunter 
einfacher entfernen lässt. 
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⑨ Entfernen Sie den Schaumstoff vom 
Boden der Plattform und drücken Sie 
die Plattform dann langsam mit den 
Händen nach unten. Dadurch 
vereinfacht sich die spätere 
Installation. 

⑩ Nun haben Sie alles ausgepackt. 
Bewahren Sie das Verpackungs- 
material auf, falls sie es später noch 
einmal benötigen sollten. 

 

 

  



 

 www.bresser.de  
 
 

20 

2.2.2 Installation 
2.2.2.1 Extruder Montage 

① Senken Sie zuerst die Plattform ab. 
Setzen Sie den Dual-Extruder dann auf 
die Extruderaufnahme. 

② Nehmen Sie den M2.5-
Innensechskantschlüssel aus dem 
Werkzeugbeutel und die vier (4) M3-
Schrauben aus dem Zubehörset. 

③ Richten Sie den Extruder an den 
Schraubenlöchern aus. 

④ Verschrauben Sie den Extruder mit den 
M3x-Schrauben an der 
Extruderaufnahme. 

 
  

Schraubenloch Schraubenloch 
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2.2.2.3 Filament-Führungsrohr und Einlegen des Filaments 

 
① Für die Montage eines Spulenhalters nivellieren Sie diesen. Dann führen Sie das 

Ende in die entsprechende Öffnung ein. 

 

② Drehen Sie den Spulenhalter so nach unten, dass der Bodenspalt der Halterung 
an der Rückseite des Druckers sitzt. 

 

③ Nehmen Sie eine Filamentrolle, drücken Sie das Oberteil des Spulenhalters 
zusammen und setzen Sie die Filamentspule in die Halterung ein. 
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Tipps 
 
① Die Filamentspule muss richtig 

ausgerichtet sein (siehe unten). 

② Nach dem Befestigen des 
Filamentführungsrohres drücken Sie 
den linken Federniederhalter des 
Extruders nach unten. Führen Sie das 
Filament dann vom anderen Ende 
des Filamentführungsrohres aus 
senkrecht in die linke 
Filamentaufnahme ein. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Hinweis: Führen Sie das Führungsrohr bitte vollständig in die Spule ein, damit 
das Filament nicht verdrillt und sich um die Außenseite der Spule wickelt. 

  

Filamentführungsrohr 
Rohrklammer 

Begrenzte Aufnahme 

Befestigen Sie das Filamentführungsrohr mit den 
R-förmigen Spangen. 
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2.2.2.4 Montage der oberen Abdeckung 

Montieren Sie die obere Abdeckung für ABS-Drucken; entfernen Sie die obere 
Abdeckung für PLA-Drucken. 

 
 

2.2.2.5 Montage der Feuchtigkeitsabweisende Platte 

 
Befestigen Sie die Feuchtigkeitsabweisende Platte mit zwei Schrauben. 

Die Düsen müssen die Feuchtigkeitsabweisende Platte nach der Montage richtig 
berühren. Die Distanz zwischen Düse und Platte kann von Hand angepasst werden. 
Nach mehreren Druckvorgängen sind Kratzer auf der Oberfläche der Platte normal. 
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2.3 Die Ersteinstellung 
2.3.1 Be- und Entladen des Filaments 

     
① Tippen Sie auf die Schaltfläche [Tools]-[Filament] 

     
② Tippen Sie auf die Schaltfläche [Load]. Der Aufwärmprozess des Extruders 

beginnt. Sobald die Zieltemperatur erreicht wurde, führen Sie das Filament bitte 
von Hand in das Filamentzuführrad ein. Wenn Filament aus der Düse austritt, ist 
der Ladevorgang abgeschlossen. 

 
③ Tippen Sie auf die Schaltfläche [Unload]. Der Aufwärmprozess des Extruders 

beginnt. Sobald die Zieltemperatur erreicht wurde, führen Sie ein Teil des 
Filaments von Hand aus der Düse. Drücken Sie dann den Federniederhalter nach 
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unten, ziehen Sie das Filament schnell heraus und beenden Sie den 
Entladevorgang. 

2.3.2 Nivellierung 
Um Nivellierfehler zu vermeiden, muss das Restmaterial zuerst aus der Düse 
entfernt werden. 

     
① Tippen Sie auf die Schaltfläche [Tools]-[Level], um mit der Nivellierung zu 

beginnen. Das Gerät fährt zuerst zurück in die Grundstellung. 

 

② Sobald die Bewegung von Extruder und Plattform stoppt, ziehen Sie die drei 
Muttern unter der Plattform gegen den Uhrzeigersinn fest. (Dieser Vorgang ist 
wichtig, um Kratzer auf der Konstruktionsplatte durch den Extruder zu 
vermeiden). 

 

under 
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③ Wählen Sie einen Extruder und bewegen Sie ihn von Hand bis zur ersten Mutter. 
Legen Sie ein Blatt Papier unter den Extruder und ziehen Sie die Mutter an, um 
die Distanz zwischen Extruder und Plattform zu verringern. Entfernen Sie das 
Papier vorsichtig und fühlen Sie die Reibung. Wenn das Papier nur leichte 
Reibung aufweist, ist die Distanz zwischen Extruder und Plattform richtig 
eingestellt. Nachdem die Einstellung der ersten Platte abgeschlossen ist, 
wiederholen Sie den Vorgang für die zweite und die dritte Mutter. 

Hinweis: Die geringe Distanz zwischen Extruder und Plattform erschwert die 
Entnahme von gedruckten Objekten. Größere Distanzen führen zu Klebefehlern 
oder Umwicklungen. 
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2.3.3 XYZ-Achskalibrierung 
Z-Achskalibrierung 

     

① Tippen Sie auf [Tools]-[Setting]-[Z Calibration]. Der Drucker nutzt einen 
Kompensationsschichtmechanismus. Die Montagepositionen der rechten und 
linken Düsen müssen nicht von Hand angepasst werden. Ein Programm 
berechnet die Höhendifferenz zwischen den beiden Düsen. 

     
② Der Extruder und die Plattform bewegen sich zuerst zurück in die Nullstellung. 

Wählen Sie dann einen Extruder für die Kalibrierung aus. Wenn die Temperatur 
von Düse und Plattform zu hoch ist, wartet das Gerät, bis die Temperatur auf 50 
°C abgekühlt ist, damit die Düse das Konstruktionsband nicht verbrennt. 
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③ Befolgen Sie die Bildschirmanweisungen und legen Sie die Nivellierkarte 
zwischen Düse und Plattform ein. Justieren Sie den Abstand mithilfe von „Z-“ und 
„Z+“. Der Einstellbereich bezieht sich auf das Nivellierpapier. Sobald Sie geringen 
Reibungswiderstand spüren, ist die Distanz zwischen Düse und Plattform richtig 
eingestellt. Nachdem der erste Extruder kalibriert wurde, erfolgt die Umschaltung 
zur Kalibrierung des nächsten Extruders. 

Hinweis: Die Muttern unter der Plattform dürfen während der Z-
Achskalibrierung nicht gedreht werden. 

 

X-Achskalibrierung 
X-Achskalibrierung: Einheitliche Anpassung der beiden Extruder in Richtung der X-
Achse, um Fehlausrichtungen während des Drucks zu vermeiden. 

     
① Berühren Sie nach Abschluss der Z-Achskalibrierung [Setting]-[X Calibration] 

oder fahren Sie mit der Kalibrierung der X-Achse fort. Nachdem die 
Initialisierungsbewegung des Gerätes ausgeführt wurde, werden die Düse und die 
Plattform erwärmt. Vergewissern Sie sich nun, dass das Filament in den Extruder 
eingeführt wurde. 

 

② Sobald die Aufwärmphase abgeschlossen ist, drucken der linke und der rechte 
Extruder nacheinander eine Linie. 
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③ Berühren Sie entsprechend der gedruckten Linien „X-“, „X+“, um die 

Extruderabweichungen anzupassen und die gedruckten Linien zu entfernen. 
Berühren Sie die Schaltfläche [Verify]. Die beiden Extruder (links und rechts) 
drucken die Linien erneut, damit ihre Übereinstimmung geprüft werden kann. 
Wenn sie übereinstimmen, ist die Kalibrierung der X-Achse abgeschlossen. 
Andernfalls muss die Justierung fortgesetzt werden, bis Übereinstimmung 
hergestellt ist. 

Y-Achskalibrierung 

Y-Achskalibrierung: Einheitliche Anpassung der beiden Extruder in Richtung der Y-
Achse, um Fehlausrichtungen während des Drucks zu vermeiden. 

     
① Berühren Sie abschließend [Setting]-[Y Calibration] oder fahren Sie nach 

Abschluss der X-Achskalibrierung mit der Kalibrierung der Y-Achse fort. Nachdem 
die Initialisierungsbewegung des Gerätes ausgeführt wurde, werden die Düse und 
die Plattform erwärmt. Vergewissern Sie sich nun, dass das Filament in den 
Extruder eingeführt wurde. 
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② Sobald die Aufwärmphase abgeschlossen ist, drucken der linke und der rechte 
Extruder nacheinander eine Linie. 

     

③ Berühren Sie entsprechend der gedruckten Linien „Y-“, „Y+“, um die 
Extruderabweichungen anzupassen und die gedruckten Linien zu entfernen. 
Berühren Sie die Schaltfläche [Verify]. Die beiden Extruder (links und rechts) 
drucken die Linien erneut, damit ihre Übereinstimmung geprüft werden kann. 
Wenn sie übereinstimmen, ist die Kalibrierung der Y-Achse abgeschlossen. 
Andernfalls muss die Justierung fortgesetzt werden, bis Übereinstimmung 
hergestellt ist. 
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2.3.4 Erster Druck 
Nach der Montage, dem Laden des Filaments und der Kalibrierung beginnen Sie 
Ihren ersten Druck. 

 

① Führen Sie die SD-Karte an der Seite des Gerätes ein. 

         

 

② Berühren Sie [Print]-[SD-Karte] und wählen Sie die Testdatei für den Druck aus. 
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2.3.5 Modell entfernen 
Heiß! Senken Sie die Plattform vor der Entnahme des Modells zuerst ab. 
Achten Sie auf die Entnahmerichtung, um Kratzer durch das Abstreifermesser 
zu vermeiden. 

Die Konstruktionsplatte darf währen der Entnahme des Modells nicht beschädigt 
werden. Kratzer auf der Konstruktionsplatte können Druckfehler erzeugen. 

 Abkühlung des Modells 
Das Modell wird ohne Klebstoff auf der Konstruktionsplatte gedruckt. 
Nachdem die gedruckten Objekte und die Konstruktionsplatte abgekühlt sind, 
lassen sich die Modelle einfach entnehmen. 

 
 Verwendung des Abstreifermessers 

Nach der Abkühlung haftet das gedruckte Objekt weiterhin an der Plattform. 
Es kann mithilfe des Spachtel von dieser gelöst werden. Halten Sie die Klinge 
parallel zur Druckplattform und führen Sie sie vorsichtig am Boden des 
Modells ein. Entfern Sie das Modell dann mit wenig Kraftaufwand. 
 

2.3.6 Stützen entfernen 
Die PVA-Stützen werden nach der Verarbeitung entfernt. Legen Sie die PVA-Stützen 
in Wasser, um sie zu vom Modell zu lösen. 

① Legen Sie die gedruckten Objekte in Wasser. 
Legen Sie die gedruckten Objekte mit den PVA-Stützen in Wasser, um die PVA-
Stützen zu lösen. Es gibt einige Möglichkeiten, um den Lösevorgang zu 
beschleunigen. 

 Die Verwendung von warmem Wasser beschleunigt den Lösevorgang. Wenn 
die Hauptstruktur der gedruckten Objekte PLA ist, darf die Wassertemperatur 
35° C nicht überschreiten. Andernfalls verformt sich das gedruckte Modell. 

 Das Wasser umrühren. Umrühren kann das Auflösen des PVAs beschleunigen. 
 Weichen Sie die gedruckten Objekte circa 10 Minuten in Wasser ein. Entfernen 

Sie die Stützen dann mit einer Zange. Legen Sie die gedruckten Objekte in 
Wasser, um PVA-Rückstände zu lösen. 

 

② Mit Wasser abspülen 
Nachdem die PVA-Stütze vollständig gelöst wurde, waschen Sie das Objekt mit 
Wasser ab, um das restliche PVA zu entfernen. 

③ Modell trocknen 
Lassen Sie das Modell vollständig trocknen und bearbeiten Sie das Objekt ggf. 
weiter. 

④ Abwasserentsorgung 
PVA ist biologisch abbaubar und somit kann das  Abwasser problemlos entsorgt 
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werden. Nachdem das Abwasser entsorgt wurde, waschen Sie das Objekt 30 
Minuten mit heißem Wasser ab, um restliches PVA aus dem Ablassrohr zu 
entfernen, so dass Blockierungen vermieden werden. Das Wasser kann 
mehrmals verwendet werden, um mehrere Objekt darin einzuweichen. Allerdings 
verlängert sich die Auflösungszeit gegebenenfalls. Daher wird empfohlen, frisches 
Wasser zu verwenden, weil sich dann die beste Wirkung erzielen lässt. 
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2.3.7 Materialverträglichkeit 
Der Drucker verfügt über zwei unabhängige Extruder und unterstützt PLA, ABS, 
HIPS und PVA. Kombimodus: 

PVA+PLA HIPS+ABS PLA+PLA ABS+ABS 

Mit BRESSER-Materialien lassen sich die besten Ergebnisse erzielen, allerdings 
unterstützt BRESSER T-REX 2 auch die Verwendung von Materialien anderer 
Marken. Alle BRESSER-Materialien wurden getestet. Mit REXprint wurden die 
besten Testergebnisse erzielt. 

PVA-Filament ist wasserlöslich und weist starke wasserabsorbierende Eigenschaften 
auf. Das Filament kann nach dem Absorbieren von Wasser weich werden, was 
Fehldrucke mit sich bringen kann. Legen Sie das PVA-Filament während des Drucks 
in eine trockene Box. PVA muss dicht verschlossen und trocken aufbewahrt werden. 

Um die besten Ergebnisse zu erzielen, müssen für jedes Material die 
entsprechenden Einstellungen vorgenommen werden. 

Wenn REXprint für das Slicen des Modell verwendet wird, werden diese 
Einstellungen automatisch vorgenommen, wenn der richtige Extruder und geeignetes 
Material ausgewählt werden. 

Anpassung von Materialparametern 
Unterschiedliche Filament-Marken weisen unterschiedliche Materialeigenschaften 
auf. Daher wird die Verwendung des Expertenmodus für die Feinabstimmung der 
Parameter empfohlen, so dass eine gute Druckqualität gewährleistet ist. 

 Festlegung der Dicke der ersten Schicht Die Haftung auf der Plattform 
verbessert sich, wenn die erste Filamentschicht aufgebracht wird. 

 Legen Sie die Plattformtemperatur für den Druck von kleinen PLA-Modellen 
mit 30°C fest bzw. immer dann, wenn die Umgebungstemperatur 25°C 
überschreitet. 

 Legen Sie die Plattformtemperatur für den Druck von großen PLA-Modellen 
mit 50° C fest bzw. immer dann, wenn die Umgebungstemperatur 10° C 
unterschreitet. 

 Die offene Druckkammer eignet sich für PLA-Drucke. Nehmen Sie die obere 
Abdeckung ab. 

 Die geschlossene Druckkammer eignet sich für ABS-Drucke. Schließen Sie 
hierbei die obere Abdeckung, damit das Filament nicht bricht. 

 Es wird empfohlen, die normale Druckgeschwindigkeit um 40°% zu verringern. 
Legen Sie das PVA-Filament in einen trockenen Kasten, so dass kein Wasser 
aus der Luft aufgenommen wird, was zu Fehldrucken führen kann. 
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2.4 Touchscreen-Oberfläche – Einführung 
Druck-Oberfläche 

     

 

① Führen Sie die SD-Karte seitlich in das Gerät ein. Während des Druckvorgangs 
muss die SD-Karte in den Drucker eingeführt sein und zwar unabhängig davon, 
ob Sie von der SD-Karte drucken oder REXprint über ein USB-Kabel anschließen. 

      Berühren Sie [Print]-[SD-Karte] und wählen Sie die Dateien für den Druck aus. 

     

② Um die Temperatur zu ändern, berühren Sie die Extruder- oder Plattform-
Temperaturanzeige am Touchscreen. 
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③ Tippen Sie auf [More], um den Druckvorgang anzuhalten oder um das Filament 

während des Druckvorgangs auszuwechseln. 

Vorwärmen-Oberfläche   

     

① Tippen Sie auf [Preheat], um den Extruder oder die Plattform vorzuwärmen. 
Legen Sie die Solltemperatur durch Berühren am Touchscreen fest. 

 

② Tippen Sie auf [Stop], um das Aufwärmen zu beenden. Berühren Sie den 
schwarzen Pfeil für die Rückkehr zum Hauptfenster. Sobald die gewünschte 
Vorwärmtemperatur erreicht ist und wenn keine weiteren Eingaben erfolgen, 
stoppt der Vorwärmvorgang. 

  



 

 www.bresser.de  
 
 

37 

Werkzeug Oberfläche 

     
Die Werkzeug-Oberfläche enthält die Registerkarten „Filament“, „Level“, „Home“, 
„Manual“, „Setting“, „Status“ und „About“. 

 

     
[Filament] 
Filament Be- und Entladeeinstellungen. 

 

     
[Level] 
Die Flachheit der Plattform wird manuell angepasst. 
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Sobald die Bewegung von Extruder und Plattform stoppt, ziehen Sie die drei Muttern 
unter der Plattform gegen den Uhrzeigersinn fest. (Dieser Vorgang ist wichtig, um 
Kratzer auf der Konstruktionsplatte durch den Extruder zu vermeiden.) 

     
Wählen Sie einen Extruder und bewegen Sie ihn von Hand bis zur ersten Mutter. 
Legen Sie ein Blatt Papier unter den Extruder und ziehen Sie die Mutter an, um die 
Distanz zwischen Extruder und Plattform zu verringern. Entfernen Sie das Papier 
vorsichtig und fühlen Sie die Reibung. Wenn das Papier nur leichte Reibung 
aufweist, ist die Distanz zwischen Extruder und Plattform richtig eingestellt. Nachdem 
die Einstellung der ersten Platte abgeschlossen ist, wiederholen Sie den Vorgang für 
die zweite und die dritte Mutter. 

     
 

under 
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[Manuell] 
Berühren Sie den Touchscreen für die Steuerung der XYZ-Achsbewegung. 

 

 
[Setting] 
Die Oberfläche „Setting“ umfasst „X Calibration“, „Y Calibration“, „Z Calibration“, 
„Expert Mode“, „Language“ und „FactoryReset“. 

 

 
[X Calibration, [Y Calibration], [Z Calibration] 

Weitere Informationen entnehmen Sie bitte Kapitel 2.3.3. 
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[Expertenmodus] 
Vereinfachte Kalibrierung für erfahrene Benutzer im Expertenmodus. Die Platzierung 
des Extruders auf der X- oder Y-Achse lässt sich entsprechend dem 
Abweichungswert des von zwei Extrudern auf derselben Achse gedruckten Modells 
anpassen. 

 

     
Wenn der linke Extruder auf der X-Achse nach rechts druckt, berühren Sie [X-]. 
Wenn der linke Extruder auf der X-Achse nach links druckt, berühren Sie [X+]. 

Wenn der rechte Extruder auf der Y-Achse nach links druckt, berühren Sie [Y-]. 
Wenn der rechte Extruder auf der X-Achse nach rechts druckt, berühren Sie [Y+]. 
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[Language] 
Unterstützung: Chinesisch, Englisch, Japanisch, Deutsch, Französisch und 
Spanisch. 

 

     
[Werkseinstellungen] 

Nach dem Berühren werden alle Werte auf die Werkseinstellungen zurückgesetzt. 

 

 
[Status] 

Unter „Status“ werden die Extruder- und die Plattformtemperatur sowie die 
Koordinaten der XYZ-Achse angezeigt. Berühren Sie die Leuchten-Statusleiste. Das 
Umgebungslicht in der Kammer des Gerätes verändert sich gemäß den 
Einstellungen. 
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[Infos] 

Die grundlegenden Geräteinformationen werden angezeigt. Die angezeigten 
Informationen variieren abhängig von dem aktuellen Gerät. 

Hier werden die Firmware-Version des Gerätes, das Druckvolumen, die gesamte 
Druckzeit usw. angezeigt. 

 
Hinweis: Geben Sie bei Kontakt mit dem Kundendienst bitte stets die 
Seriennummer an. 

 

 

[Firmware Upgrade] 

Methode 1: 

Führen Sie die SD-Karte in den Computer ein und legen Sie einen Ordner mit der 
Bezeichnung „sys“ an. Kopieren Sie die Firmware-Dateien in den Ordner „sys“. 
Führen Sie die S-Karte dann in das Gerät ein. Schalten Sie das Gerät ein und 
aktualisieren Sie die Firmware. Nach der Aktualisierung der Firmware löschen Sie 
den Ordner „sys“. 

Methode 2: 

Aktualisieren Sie die Firmware über ein USB-Kabel mit REXprint. 
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Kapitel 3: Slicing-Software 
 

Mithilfe der Slicing-Software REXprint werden .stl- und .obj-Dateien in .g-Dateien 
umgewandelt, die mit BRESSER T-REX 2 gedruckt werden können. 

3.1 Installation 
3.1.1 Wie erhalte ich REXprint? 
Es gibt zwei Möglichkeiten, um die REXprint-Software zu erhalten: 

Methode 1: Laden Sie das Installationspaket von der SD-Karte im Zubehörset 
herunter. 

Methode 2: Laden Sie die aktuelle Version aus dem Download Center von der 
Bresser Produktwebsite www.bresser.de/P2010600 herunter. 

3.1.2 Erste Schritte 
Extrahieren Sie die Zip-Datei oder starten Sie das Installationsprogramm. Installieren 
Sie die Software gemäß den Anleitungen. 

Starten Sie die Software mit Startmenü-Tastaturkürzel durch Berühren des Software-
Symbols. 
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3.2 Lernen Sie REXprint kennen 
Hinweis: 
BRESSER T-REX 2 unterstützt den Druck aus REXPrint über ein USB-Kabel. 

3.2.1 Auswahl des Gerätetyps 
Achtung! Nach dem Starten von REXPrint müssen Sie zuerst den Gerätetyp 
auswählen. 

Nach dem Starten von REXPrint wird ein Dialogfeld angezeigt. Wählen Sie 
BRESSER T-REX 2 aus der Liste der angezeigten Gerätetypen aus und tippen Sie 
auf [OK]. Sie können den Gerätetyp auch durch Berühren von [Print]-[Machine 
Type] ändern. Siehe nachstehende Abbildung: 
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3.2.2 Vorstellung von REXPrint 

 
 

 
Laden (Load) 
Jeweils nur eine Datei laden  

Stützen (Support) 
Stützen-Bearbeitungsmodus 
öffnen. 

 
Drucken (Print) 
Direkt mit dem BRESSER T-REX 
2 drucken oder auf einen USB-
Stick exportieren 

 
Ansicht (View) 
Ansicht FlashPoint 
Startbildschirm, aus einem von 
sechs Blickwinkeln 

 
Bewegen (Move) 
Bewegen des Modells auf der XY-Achse. Für die Bewegung auf der Z-
Achse „Umschalten+Klicken“. 

 
Drehen (Rotate) 
Drehen und wenden Ihres 
Modells. 

 
Skalierung 
Größenskalierung Ihres Objektes 

 
Schneiden (Cut) 
Modell in mehrere Teile 
zerschneiden 

 
Extruder 
Vor dem Festlegen des 
Parameter den linken oder 
rechten Extruder auswählen 
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3.2.3 Laden  
Mithilfe der nachstehenden sechs Methoden können Sie eine Modell- oder Gcode-
File in REXprint laden: 

Methode 1:  Berühren Sie auf der Hauptoberfläche das Symbol [Laden].  

Methode 2:  Wählen Sie dann die Objektdatei aus. Wählen Sie die Datei, die Sie 
laden möchten, und ziehen Sie sie auf die Hauptoberfläche der 
Software. 

Methode 3:  Berühren Sie [File]--[Load File]. Wählen Sie dann die zu ladende 
Objektdatei aus.  

Methode 4:  Berühren Sie [File]--[Examples], um die Beispieldateien zu laden. 

Methode 5:  Berühren Sie [File]--[Recent Files], um die zuvor geladenen Dateien 
zu öffnen.  

Methode 6:  Markieren Sie die Zieldatei an, berühren Sie diese und ziehen Sie sie 
zum REXprint-Symbol. 

Hinweis: 3D-Modelle können als .STL-, .OBJ- oder .FPP-Datei gespeichert und 
mit REXPrint bearbeitet werden. 

 

Erweitert: Gestalten von Reliefs 

  
Shape: Umfasst die Formen „Plane“, „Tube“, „Canister“, „Lamp“, „Seal“ und „Lamp“. 
Mode: Umfasst „dunkler ist höher“ und „leichter ist höher“. 
Maximum thickness: Z-Wert des Modells. 
Base thickness: Die minimale Raft-Dicke: Standardwert 0,5 mm. 
Width: X-Wert des Modells. 
Depth: Y-Wert des Modells. 
Bottom thickness: Festlegung der Bodendicke für die Formen „Tube“, „Canister“, 
„Seal“ und „Lamp“. 
Top diameter: Festlegung des oberen Durchmessers für die Formen „Tube“, 
„Canister“ und „Lamp“. 



 

 www.bresser.de  
 
 

47 

Bottom diameter: Festlegung des Bodendurchmessers für die Formen „Tube“, 
„Canister“ und „Lamp“. 
 

Plane Tube/Canister 

 

 

Lamp Seal 
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3.2.4 Ansichten 
① Ändern von Ansichten 

Ändern Sie die Modellansichten durch Bewegen, Drehen und Skalieren. 

● Ziehen 

Auf das Symbol „View“  klicken. Das Objekt kann dann anhand einer der 
folgenden drei Methoden bewegt werden: 

Methode 1: Bei gedrückter linker Maustaste ziehen. 

Methode 2: Bei gedrückter mittlerer Maustaste ziehen. 

Methode 3: Bei gedrückter Umschalttaste und gleichzeitig gedrückter rechter 
Maustaste ziehen.  

● Drehen 

Auf das Symbol [View]  klicken. Das Objekt kann dann anhand einer der 
folgenden zwei Methoden gedreht werden: 
Methode 1: Halten Sie die rechte Maustaste gedrückt, und ziehen Sie. 
Methode 2: Umschalttaste und linke Maustaste gedrückt halten und ziehen. 

● Skalieren 
Das Mausrad drehen, um die Druckplatte zu vergrößern oder zu verkleinern.   
 
② Festlegen der Ansicht 
Der Benutzer kann das Objekt auf der Druckplatte betrachten. Im Ansichtsmenü 
stehen sechs Ansichten zur Verfügung, d. h. die Startansicht, die Ansicht von unten, 
von oben, von hinten, von vorne, von links und von rechts.  

Methode 1: Auf die Schaltfläche  [View] klicken. Daraufhin werden in der 
Dropdown-Liste sechs Ansichten aufgeführt.  

Methode 2: Auf die Schaltfläche  [View] klicken und klicken dann erneut klicken, 
um ein Untermenü zu öffnen, in dem die sechs Ansichten zur Auswahl bereitstehen. 
 
③ Zurücksetzen der Ansicht 
Es gibt die folgenden beiden Möglichkeiten, um Ansichten zurückzusetzen: 
Methode 1: Klicken Sie auf den Menü [View], und wählen Sie [Home View]. 

Methode 2: Klicken Sie links auf die Schaltfläche  [View], und klicken Sie erneut 
darauf, um die Anzeigeoptionen anzuzeigen. Sie können dann auf [Reset] klicken. 
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④ Anzeigen des Modellumrisses 

Auf  [View] > [Show Model Outline] klicken. Daraufhin wird die gelbe Außenlinie 
des Objekts hervorgehoben. 

 

⑤ Anzeigen eines steilen Überhangs 

Auf  [View] > [Show Steep Overhang] klicken. Wenn sich der Schnittwinkel 
zwischen der Modelloberfläche und der horizontalen Linie im Bereich des 
Schwellenwerts für den Überhang befindet, weist die Oberfläche einen steilen 
Überhang auf und wird in der Software in Rot dargestellt. Der Schwellenwert für den 
Überhang kann nach Bedarf angepasst werden. Standardmäßig ist der Wert auf 45° 
festgelegt. 

 

3.2.5 Bewegen 
Wählen Sie das gewünschte Objekt aus, und bewegen Sie es anhand einer der 
folgenden beiden Methoden: 

Methode 1: Klicken Sie links auf das Symbol  [Move], halten Sie die linke 
Maustaste gedrückt, und ziehen Sie, um die Position des Modells in der XY-Richtung 
zu verschieben. Halten Sie die Umschalttaste und die linke Maustaste gedrückt, und 
ziehen Sie, um die Position des Modells in der Z-Richtung zu verschieben. Der 
Abstand und die Bewegungsrichtung werden angezeigt. 

Methode 2: Klicken Sie links auf die Schaltfläche  [Move], und geben Sie dann 
einen Wert für den Abstand ein. Klicken Sie auf [Reset], um die Abstandswerte 
zurückzusetzen. 

Hinweis: Nach der Positionsanpassung sollte man auf [Center] und [On Platform] 
klicken, um sicherzustellen, dass sich die Modelle im Druckbereich und auf der 
Druckplattform befinden. Wenn eine bestimmte Position erforderlich ist, klicken Sie 
nur auf [On Platform]. 
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3.2.6 Drehen 
Wählen Sie das gewünschte Objekt aus, und drehen Sie es anhand einer der 
folgenden beiden Methoden:  

Methode 1: Klicken Sie links auf das Symbol  [Rotate]. Daraufhin werden drei 
im rechten Winkel zueinanderstehende Ringe um das Objekt herum angezeigt. 
Klicken Sie auf einen Ring, und nehmen Sie eine Drehung um die aktuelle Achse 
herum vor. Sie können dann den Drehwinkel und die Richtung in der Mitte des Rings 
sehen. Auf diese Weise können Sie das Modell um die X-/Y-/Z-Achsen drehen. 

Methode 2: Klicken Sie links auf das Symbol  [Rotate], und geben Sie dann die 
Drehwinkelwerte für die Positionierung für die X-/Y-/Z-Achsen ein. Klicken Sie auf 
[Reset], um die Drehwinkelwerte zurückzusetzen. 

 

3.2.7 Skalieren 
Wählen Sie das gewünschte Objekt aus, und skalieren Sie es anhand einer der 
folgenden beiden Methoden:  

Methode 1: Klicken Sie links auf das Symbol  [Scale], halten Sie die linke 
Maustaste gedrückt, und skalieren Sie das Modell. Die entsprechenden Werte werden 
neben dem Objekt angezeigt. 

Methode 2: Klicken Sie links auf das Symbol  [Scale], und geben Sie dann die 
Skalierungswerte für die Positionierung für die X-/Y-/Z-Achsen ein. Klicken Sie auf die 
Schaltfläche [Maximum], um die maximal mögliche Größe für den Druck zu erzielen. 
Klicken Sie auf [Reset], um die Größe des Modells zurückzusetzen. 

Hinweis: Wenn Sie auf das Optionsfeld [Uniform Scaling] geklickt haben, wird das 
Modell maßstabsgetreu skaliert, wenn Sie einen beliebigen Wert der Positionierung 
des Modells ändern. Anderenfalls wird nur der entsprechende Positionswert 
geändert. 
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3.2.8 Schneiden 
Klicken Sie mit der linken Maustaste auf das Modell, um es auszuwählen, und 

doppelklicken Sie dann auf das Symbol „Cut“ , um die Schnittebene 
festzulegen. Sie können die Richtung und die Position festlegen. 

① Mit Maus zeichnen 

 

 

 

 

 

 
② X-Ebene 

 

 

 

 

 

③ Y-Ebene 
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④ Z-Ebene 

 

 

 

 

 

 

3.2.9 Extruder  
Es gibt rechte und linke Extruder. Wählen Sie zuerst das Modell. Klicken Sie auf das 
Extruder-Symbol. Das Einstellungsmenü für den Extruder wird angezeigt. Vor Beginn 
des Druckvorgangs muss der linke oder der rechte Extruder ausgewählt werden. 
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3.2.10 Stützen  
Nachdem Sie das Modell geladen haben, klicken Sie auf [Edit] > [Supports] oder 

direkt auf das Symbol  Supports. Sie wechseln dann in den 
Bearbeitungsmodus für Stützen (wie in der Abbildung unten dargestellt). Klicken Sie 
auf [Back], um diesen Modus zu verlassen, wenn Sie die Bearbeitung 
abgeschlossen haben. 

 

① Stützenoptionen 

Wenn Sie auf „Support Options“ klicken, wird ein Optionsfeld angezeigt, in dem die 
Stützenoptionen „Treelike“ und „Linear“ aufgeführt werden. Wenn Sie die Option 
„Treelike“ auswählen und auf [OK] klicken, wird eine Baumstruktur erstellt. Wählen 
Sie hingegen „Linear“ und klicken dann auf [OK], wird eine lineare Struktur erstellt. 
Wenn das Modell bereits über Stützen verfügt und Sie eine der Stützenoptionen 
auswählen, beurteilt die Software, ob die vorhandenen Stützen gelöscht werden 
müssen. Diese Entscheidung erfolgt auf Grundlage des ausgewählten Stützentyps. 
Sie können diese Entscheidung in einem Popup-Fenster bestätigen. 
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② Automatische Stützen 
Klicken Sie auf die Schaltfläche [Auto Supports]. Die Software beurteilt die 
Positionen, an denen Stützen erforderlich sind, und erstellt entsprechende Stützen 
im Baumformat oder linearen Format. Bei einem Modell mit Stützen werden die 
vorhandenen Stützen entfernt und neue erstellt. 

③ Hinzufügen von Stützen 
Stützen werden hinzugefügt, wenn Sie auf die Schaltfläche [Add] klicken. 
Positionieren Sie den Mauszeiger an der Stelle, an der eine Stütze erforderlich ist, 
klicken Sie mit der linken Maustaste, um den Anfangspunkt für die Stütze 
auszuwählen, halten Sie die linke Maustaste gedrückt und ziehen Sie die Maus. Die 
Stützenvorschau wird geöffnet (sofern für die Fläche keine Stütze erforderlich ist 
oder der Winkel der Stützsäule zu groß ist, wird das in der Stützenansicht 
hervorgehoben). Lassen Sie die linke Maustaste los. Wenn die Stützsäule für ein 
Modell nicht geeignet ist, wird die Stütze am Ausgangs- und Endpunkt erstellt (durch 
die hervorgehobene Stütze in der Vorschau wird keine Stützstruktur erstellt). 

④ Entfernen von Stützen 
Klicken Sie auf [Clear Supports]. Daraufhin werden alle Stützen gelöscht. Diesen 
Löschvorgang können Sie rückgängig machen, indem Sie auf [Undo] klicken oder 
die Tastenkombination Strg+Z drücken. 
  



 

 www.bresser.de  
 
 

55 

⑤ Löschen von Stützen 
Stützen werden gelöscht, wenn Sie auf die Schaltfläche [Delete] klicken. 
Positionieren Sie den Mauszeiger auf der Stütze, die gelöscht werden soll. Die 
aktuelle Stütze und die zugehörigen Unterknoten werden hervorgehoben. Drücken 
Sie die linke Maustaste, um die hervorgehobene Stütze zu löschen. 

 

3.2.11 Drucken 
Klicken Sie auf das Drucken-Symbol. Nun wird der Druckbildschirm angezeigt. 
Nachdem alle Parameter festgelegt wurden, klicken Sie auf [OK]. Wählen Sie dann 
das richtige Dateiformat und klicken Sie auf [Speichern]. 
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Preview: Vorschau-Oberfläche öffnen oder nicht öffnen. Durch Auswahl 
dieser Option wird die Vorschau nach Abschluss des Slicens 
automatisch angezeigt. Schieben Sie den Modellschicht-
Schieberegler auf der linken Seite der Oberfläche nach oben 
und unten, um die Modellschicht anzuzeigen. Die geschätzte 
Druckzeit für das Modell und das Filament werden oben rechts 
angezeigt. Klicken Sie auf [Print], um das Gerät zu verbinden. 
Klicken Sie auf [Back], um erneut die Hauptoberfläche 
anzuzeigen. 

Materials: ABS/PLA 

Supports: Für den Druck von ab-/aufgehängten Modellen wird eine Stütze 
benötigt. Durch Anklicken von [Support] wird ein Stützenteil für 
den Druck erzeugt. 

Raft: Mithilfe dieser Funktion haftet das Modell gut auf der Plattform. 

Wall: Während des Dual-Farbdrucks schützt diese Funktion vor 
Kontakt mit einem aus einem anderen Extruder austretendem 
Filament. 

Brim: Ausweitung der Bodenschichten des Modells, so dass die 
Ränder des Modells so an der Plattform verankert werden, dass 
es sich nicht verzieht oder der Druck fehlschlägt. 

Resolution: Es gibt (einschließlich der Standardeinstellung) drei 
Auflösungen: hohe Auflösung entspricht einer langsamen 
Druckgeschwindigkeit, niedrige Auflösung einer schnellen. Für 
den PLA-Druck ist die „Hyper“-Funktion verfügbar. 

More options: Unter [More Options] können Einstellungen für „Lage“, 
„Schicht“, „Infill“, „Geschwindigkeit“ und „Temperatur“ 
vorgenommen werden. Die unterschiedlichen Auflösungen 
entsprechend den unterschiedlichen Standardeinstellungen. Um 
die Standardeinstellungen wieder zu übernehmen, klicken Sie 
auf [Restore Defaults]. 
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Layer Height Layer Height: Schichtdicke des 
Druckmodells. Umso kleiner der Wert, umso 
glatter wird die Oberfläche des Modells. 

 First Layer Height: Diese erste Schicht des 
Modells hat Einfluss auf die Haftleistung 
zwischen Modell und Plattform. Der 
maximale Wert beträgt 0,4 mm. 
Normalerweise ist der Standardwert 
ausreichend. 

Shells Diese umfasst den Wert für die Außenhülle, 
den Wert der Abdeckschicht (unter einem 
Vasenmuster; die Einstellung obere robuste 
Schicht ist ungültig. 
Perimeter Shells: Maximum beträgt 10 
Top Solid Layers: Maximum beträgt 30, 
Minimum beträgt 1 
Bottom Solid Layers: Maximum brtägt 30, 
Minimum beträgt 1. 

Infill Fill Density: Füllrate. 
Fill Pattern: Das Muster der Füllform. 
Dieses hat Einfluss auf die Druckdauer. 
Combine Infill: Die Schichten für die 
Kombination können gemäß der 
Schichtdicke ausgewählt werden. Die 
kombinierte Dicke sollte 0,4 mm nicht 
überschreiten. „Alle n Schichten“ bezieht 
sich auf alle Schichten. „Alle n 
Innenschichten“ betrifft nur Innen-Infills, d.h. 
die Druckzeit verkürzt sich. 

Speed Print Speed: Die Extruder-
Bewegungsgeschwindigkeit. Generell gilt: 
Umso niedriger die Druckgeschwindigkeit, 
umso besser ist das Druckergebnis. Für den 
PLA-Druck wird „80“ empfohlen. 
Travel Speed: Kontrolle der 
Bewegungsgeschwindigkeit des Extruders 
ohne Druckvorgang. Für den PLA-Druck 
wird „100“ empfohlen. 
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Hinweis: Die Parametereinstellungen 
lassen sich für unterschiedliche Modelle 
entsprechend anpassen. 

Temperature Extruder Temperature: Empfohlene 
Extrudertemperatur: 220°C. Hinweis: Die 
unterschiedlichen Temperaturen 
beeinflussen den Druckvorgang. Die 
Temperatur muss den vorherrschenden 
Bedingungen angepasst werden, damit ein 
gutes Druckergebnis erzielt werden kann. 
Platform Temperature: Festlegung der 
Plattformtemperatur. 

Others Cooling Fan Control (Kühllüftersteuerung): 
Einrichtung der Zeitspanne bis zum 
Einschalten des Kühlgebläses. Sie können 
den Wert vorab festlegen, dann wird das 
Kühlgebläse aktiviert, sobald dieser Punkt 
erreicht ist. 
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3.2.12 Dateimenüs 
① New Project 
Klicken Sie auf [File] > [New Project], um ein leeres Projekt zu erstellen. Wenn bei 
einem vorherigen Projekt eine Änderung noch nicht bestätigt ist, werden Sie gefragt, 
ob diese Änderung gespeichert werden soll oder nicht. Klicken Sie auf [Yes], um die 
Änderung zu speichern, oder auf [No], um sie zu verwerfen. Wenn Sie auf [Cancel] 
klicken oder die QuickInfo schließen, wird das neue Projekt nicht erstellt. 

 
 
② Save 
Nachdem das Modell bearbeitet und angepasst wurde, gibt es zwei Möglichkeiten, 
um alle dargestellten Modelle zu speichern. 

Methode 1: Auf [File]--[Save Project] klicken, um die Datei als Projektdatei mit der 
Dateinamenerweiterung FPP zu speichern. Alle dargestellten Modelle (einschließlich 
Stützen) bleiben voneinander unabhängig. Bei einem erneuten Laden der Datei 
entsprechen die Konfigurationsinformationen für den Extruder und die 
Modellpositionierung der Konfiguration beim Speichern der Datei. 

Methode 2: Auf [File] > [Save as...] klicken, um das Modell als Projektdatei im Format 
FPP, STL oder OBJ zu speichern. Bei den Dateiformaten STL und OBJ werden die 
Modelle in ein einziges Modell integriert (einschließlich der Stützen). Beim erneuten 
Laden dieser Dateiformate wird nur die Position des Modells gespeichert, die 
Druckparameter jedoch nicht. 
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③ Preferences 
Auf [File] > [Preferences] Klicken. Hier kann die Sprache gewählt und die Suche 
nach vorhandenen Aktualisierungen beim Gerätestart festlegt werden. 

 
● Language: Die Software unterstützt die folgenden sechs Sprachen: Chinesisch 
(vereinfachtes und traditionelles), Englisch, Französisch, Koreanisch, Japanisch und 
Russisch. 

● Printing Window Type: Umfasst den Grundmodus und den Expertenmodus  

● Check for Update After Start Up: Über diese Einstellung können Sie festlegen, 
ob die automatische Online-Aktualisierung aktiviert werden soll. Wenn Sie „Yes“ 
wählen, kann die Software bei jedem Starten online prüfen, ob eine neue 
Softwareversion verfügbar ist und, sofern dies zutrifft, den Benutzer zum 
Herunterladen und Installieren der neuen Softwareversion auffordern. 

 

3.2.13 Bearbeitungsmenü 
① Undo 
Es stehen die folgenden beiden Möglichkeiten zur Verfügung, um die zuletzt 
vorgenommenen Änderungen rückgängig zu machen: 

Methode 1: Klicken Sie auf [Edit] > [Undo].  

Methode 2: Drücken Sie die Tastenkombination Strg+Z.  

② Redo 
Es stehen die folgenden beiden Möglichkeiten zur Verfügung, um die zuletzt 
rückgängig gemachte Änderung an der Modelldatei wiederherzustellen. 

Methode 1: Klicken Sie auf [Edit] > [Redo]. 

Methode 2: Drücken Sie die Tastenkombination Strg+Y. 
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③ Empty Undo-Stack 
Über diese Funktion können Sie die gespeicherten Bearbeitungsschritte löschen, um 
Speicherplatz freizugeben. 

④ Select All  
Anhand der folgenden beiden Methoden können alle Modelle in der 
Bearbeitungsumgebung ausgewählt werden. (Wenn Modelle so klein sind, dass Sie 
sie nicht sehen können, oder sich außerhalb des Ansichtsbereichs befinden, klicken 
Sie auf die Schaltflächen [Center] und [Scale], um das Modell anzupassen.) 

Methode 1: Klicken Sie auf [Edit] > [Select All]. 

Methode 2: Drücken Sie die Tastenkombination Strg+A. 

⑤ Duplicate 
Objekt anhand einer der folgenden beiden Methoden dublizieren: 

Methode 1: Auf [Edit] > [Duplicate] klicken. 

Methode 2: Tastenkombination Strg+D drücken. 

⑥ Delete 
Objekt anhand einer der folgenden beiden Methoden löschen: 

Methode 1: Auf [Edit] > [Delete] klicken. 

Methode 2: Die Taste Entf drücken. 

⑦ Surface to Platform 
Nachdem Sie das Modell ausgewählt haben, können Sie über den folgenden 
Vorgang die Modellfläche auf die Plattform auflegen. 
Klicken Sie auf [Edit] > [Surface to Platform], um in den Modus Fläche-Auf-
Plattform zu wechseln  
(wie in der folgenden Abbildung dargestellt)  
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⑧ Auto Layout All 

Klicken Sie auf [Edit] > [Auto Layout All], nachdem Sie ein oder mehrere Modelle 
geladen haben. Daraufhin werden alle Modelle anhand der automatischen 
Platzierungsregel positioniert. 

 

3.2.14 Tool-Menüs 
Firmware-Update 
Öffnen Sie REXPrint (Ihr Computer und der Drucker müssen über ein USB-Kabel 
miteinander verbunden). Klicken Sie auf [Tools] und [Update Firmware], und dann 
auf [OK]. Es wird ein Dialogfeld angezeigt. Klicken Sie auf [Yes], um das Firmware-
Update zu starten. 
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3.2.15 Hilfe-Menü 
① Erstausführungsassistent 
Hier werden die Basisfunktionen kurz vorgestellt. 

② Hilfeinhalte 
Mit Anklicken von [Help]-[Help Contents] wird der Hilfe-Inhalt angezeigt. 

③ Auf Updates prüfen 
Durch das Anklicken von [Help]-[Check for Updates] wird nach vorhandenen 
Online-Updates gesucht. 

③ Über REXprint 
Durch das Anklicken von [Help]-[About REXprint] wird das Software-Infofenster 
angezeigt. Hier werden die aktuelle Softwareversion und die Hinweise zum 
Urheberrecht angezeigt. 

 

3.3 Wie erzeuge ich eine .g-Datei? 
Standardmäßig wird der linke Extruder als Materialextruder verwendet; der rechte 
Extruder ist der Druckextruder. Beim Drucken eines monochromen Modells wird der 
rechte Extruder automatisch als Druckextruder festgelegt, sofern diese Einstellung 
nicht vom Benutzer geändert wird. 
 

 
① Klicken Sie auf [Print]-[Machine Type] für die Auswahl Druckermodels. 
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② Klicken Sie auf das Symbol [Load], um eine .stl-Modelldatei auszuwählen. Das 

Objekt wird im Konstruktionsbereich dargestellt. 

 

Preview: Check the function recommend. 
Machine Type: BRESSER T-REX 2. 
Materials: Wählen Sie die gewünschten 
Materialien aus. 
Supports: Empfohlene Einstellung [Enable]. 
Raft: Empfohlene Einstellung [Enable]. 
Resolution: Empfohlene Einstellung 
[Standard]. 
More Options: Es wird vorgeschlagen, dass 
Sie die Standardeinstellungen beibehalten. 
 
Notiz: Die Standard-Einstellungen sind für 
Erstanwender gut geeignet. 
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3.4 Einführung in Funktionen 
Expertenmodus 
① Klicken Sie im Menü auf [File] und wählen Sie [Preferences]. Wählen Sie im 
Pop-up-Fenster den „Expertenmodus“ und klicken Sie auf [OK]. 

 
 

② Klicken Sie auf der REXprint-Oberfläche auf das Symbol [Print]. Das Fenster für 
die Parametereinstellungen wird angezeigt. Wählen Sie die Materialien, u.a. 
Creator Pro 2 PLA. Für das Drucken mit wasserlöslichen Stützen klicken Sie auf 
[General]-[Adapt Soluble Support Filament]-[PVA]-[Adapt] und dann auf 
[Save Configuration]. 

Der Expertenmodus unterstützt die Auswahl von löslichen Materialien. Klicken Sie 
darauf und legen Sie den Einzug für den linken Extruder fest. Es ist von den 
Materialeigenschaften abhängig, ob der Einzug angepasst werden muss. Die 
Einzugseinstellung kann Zeichnungen reduzieren. 
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Der Abstand zwischen Stützen und Modell und die Stützendichte können in den 
Einstellungreitern [Supports] angepasst werden. 
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Spiegel-/Duplikat-Funktionen 
Zwei identische Modelle drucken, Duplikatmodus auswählen; zwei spiegelgleiche 
Modelle drucken, Spiegelmodus auswählen. 

In den Modi „Spiegelung“ oder „Duplizieren“ drucken zwei Extruder die Modelle 
simultan. 

Hinweis: Die Größe der X-Achse des Modells sollte im Spiegel- oder 
Duplizieren-Modus 80 mm unterschreiten. 

 

① Wählen Sie Modell und klicken Sie auf [Extruder], um die Einstellung des 
Extruders zu beginnen. 
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② Nach der ausgeführten Spiegelung oder dem Duplizieren werden die Modelle im 

Baubereich angezeigt. Klicken Sie auf [Print]. Wegen des Höhenunterschieds der 
beiden Extruder im Spiegelungsmodus wird ggf. eine Kompensationsschicht 
gedruckt. Daher wird empfohlen im Spiegelungsmodus „Raft“ hinzuzufügen.  
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Stützen hinzufügen 

Hinzufügen von Stützen für ab-/aufgehängte Strukturen für ein gutes 
Druckergebnis. 

 

 
① Klicken Sie auf das [Supports]-Symbol, um die Einstellungen für die 
Stützen vorzunehmen. Die Stützeneinstellungen können automatisch 
vorgenommen werden. Klicken Sie auf der linken Seite auf [Delete], um 
die Stützen manuell zu löschen. 
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② Unter [Support Options] wählen 

Sie Baumform oder lineare Stützen 
aus. Überhangschwelle bezieht sich 
auf den Winkel des auf-
/abgehängten Modells. Wenn der 
Winkel überschritten wird, wird die 
Stütze erzeugt. 

③ Klicken Sie auf [Auto Supports], 
um Stützen automatisch zu 
erstellen. 
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Dimensionale Anpassungen 

 
Bei dimensionalen Abweichungen klicken Sie auf [Others], um die Funktionen für die 
dimensionale Verstellung zu öffnen. Positive Anpassungen von Werten erzeugen 
Vergrößerungen, negative Anpassungen erzeugen Verkleinerungen. Die Z-
Achsenhöhe wird gemäß dem Prozentwert angepasst.  
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Kapitel 4: Wartung 
 

Problem Ursache Abhilfe 
Extruderkopf außermittig Das Gerät erkennt die exakte 

Extruderposition nicht mehr und 
kann nicht bauen. 

Den Extruder in die Grundstellung 
zurückfahren um BRESSER T-REX 
2 neu zu kalibrieren. Brechen Sie 
Ihr Objekt ab, leeren Sie die 
Konstruktionsplattform, senden Sie 
den Extruder an die Grundstellung 
und starten Sie Ihr Objekt neu. 

Keine PLA-Extrusion oder 
Anhaftung am 
Konstruktionsband. 

Dies kann darauf zurückzuführen 
sein, dass die Plattform und der 
Extruderkopf nicht richtig aus-
gerichtet (nivelliert) sind. 

Durch die Nivellierung der Plattform 
wird der Extruderkopf ausgerichtet, 
wodurch sich die Qualität des 
Objektes verbessert. Brechen Sie 
Ihr Objekt ab, leeren Sie die 
Konstruktionsplattform, nivellieren 
Sie den Extruder in der 
Grundstellung und starten Sie Ihr 
Objekt neu. 

BRESSER T-REX 2 eingefroren 
vor Objektstart. 

BRESSER T-REX 2 empfängt ggf. 
widersprüchliche Befehle. 

Schalten Sie den Netzschalter aus, 
warten Sie 30 Sekunden und 
schalten Sie den Netzschalter ein. 

Verwicklungen am Ende der 
Konstruktion. 

Eine Schicht Ihres Objektes haftet 
nicht richtig an, das Modell wurde 
mit minimalem Kontakt auf der 
Konstruktionsplattform gesichert 
oder das Objekt wurde schwebend 
und ohne Stützen über der 
Konstruktionsplattform gebaut. 
Falscher Z-Achsversatz, 
Extruderspitze ist nicht mit dem 
richtigen Abstand zur 
Konstruktionsplattform 
ausgerichtet. 

Verwenden Sie die 
Vorschaufunktion Ihrer Slicing-
Software, um die Höhe und die 
Position der ersten Schicht 
anzuzeigen. Bauen Sie ggf. mit 
Stützen. Informationen zur 
Kalibrierung des Z-Achsversatzes 
erhalten Sie beim Kundendienst. 

Es tritt kein Filament aus. Extruder verstopft. Filament nicht 
richtig geladen. 

Versuchen Sie das Filament zu 
wechseln, um sich zu 
vergewissern, dass die 
Extrudergetriebe das Filament 
richtig erfasst haben. 
Wenden Sie sich an den 
Kundendienst. 

Extruder nicht in Grundstellung. Verkabelung Endlagenschalter Kundendienst hinzuziehen. 

Strähnige oder zerfranste 
Plastikschichten an steilen 
Überhängen. 

Die Objektüberhänge sind zu weit 
auseinander oder zu steil (Winkel 
unter 45 Grad). 

Bauen mit Stützen. 
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Kapitel 5: Garantie und Service 
 

Garantie 
Die Garantiezeit für dieses Gerät beträgt 5 Jahre und beginnt am Tag des Kaufs.  

Bitte bewahren Sie den Kaufbeleg (Kassenbon/Rechnung) als Nachweis für den 
Kauf sorgfältig auf. 

Während der Garantiezeit werden defekte Geräte vom Händler vor Ort angenommen 
oder ggf. von Ihnen direkt eingeschickt. Die Übersendung muss auf jeden Fall auf 
Ihre Kosten erfolgen. Im Garantiefall werden Ihnen die Portokosten erstattet. Sie 
erhalten dann ein neues oder repariertes Gerät kostenlos zurück. Die Entscheidung, 
ob eine Reparatur oder ein Tausch des Gerätes erfolgt, obliegt uns. 

Ausgenommen von dieser Garantie sind Zubehör-/Bauteile wie z.B. Aufnahmeplatten 
und -folien, Acrylglas-/Kunststoffelemente, USB-/Wechselspeichermedien, Filaments 
und -Spulen, Kleber, Harze/Fette, Gefäße und Behälter, Werkzeuge etc. 

Die Garantie erlischt, wenn am Kaufgegenstand entstandene Mängel auf folgende 
Umstände zurückzuführen sind: 

 nicht sachgemäße Benutzung 
 fahrlässige oder vorsätzliche Beschädigung durch Eigenverschulden und/oder 

nicht authorisierte Dritte 
 Reparaturen oder Abänderungen, die von fremder Seite ohne unsere 

Beauftragung vorgenommen wurden 
 Veränderungen oder Beschädigungen infolge höherer Gewalt (Unwetter, Hagel, 

Feuer, Stromausfall, Blitzschlag, Überschwemmung, Schneeschaden, 
Frosteinwirkung und sonstige Einwirkung durch Tiere, usw.) 

Die Garantie erlischt ferner, wenn ein beschädigter und/oder unleserlicher oder 
unvollständiger Kaufbeleg vorgelegt wird. 

Die Rechte aus der Garantie bestehen unabhängig von den gesetzlichen 
Gewährleistungsansprüchen. 

Garantiegeber ist die BRESSER GmbH, Gutenbergstr. 2, 46414 Rhede, 
Deutschland. 

Nach Ablauf der Garantiezeit haben Sie ebenfalls die Möglichkeit, ein defektes Gerät 
zwecks Reparatur zu übersenden. Nach Ablauf der Garantiezeit anfallende 
Reparaturen sind kostenpflichtig. Sie erhalten vor Ausführung der Reparatur einen 
Kostenvoranschlag von uns. 
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Im Falle einer Retoure beachten Sie bitte Folgendes: 

Achten Sie darauf, dass der Artikel sorgfältig verpackt verschickt wird. Nutzen Sie 
nach Möglichkeit die Originalverpackung. Füllen Sie das Service-Formular aus und 
legen Sie dieses zusammen mit dem Kaufbeleg der Sendung bei. 

 

Service 
Sie können sich an das BRESSER Service-Team wenden, wenn Sie Probleme mit 
dem 3D-Drucker haben. Falls Fragen oder Probleme in diesem Handbuch nicht 
behandelt werden, können Sie auf unserer offiziellen Website nach Lösungen 
suchen oder sich telefonisch an uns wenden. 
In unserer Knowledge Base werden Lösungen und Anweisungen für häufig 
auftretende Probleme zur Verfügung gestellt. Es empfiehlt sich, dort als Erstes nach 
einer Lösung zu suchen, da die häufigsten Fragen dort beantwortet werden. 
http://www.bresser.de   
Email: service.3d-printer@bresser.de 
Sie erreichen das BRESSER Service-Team telefonisch oder per E-Mail von Montag 
bis Samstag, 8:30-15:30 Uhr (MEZ). Sollten Sie sich außerhalb dieser 
Geschäftszeiten an uns wenden, beantworten wir Ihre Anfrage am folgenden 
Arbeitstag. 
Hinweis: Aufgrund von unterschiedlichem Filament kann der Extruder blockiert 
werden. Dieses Problem stellt kein Qualitätsproblem dar und liegt außerhalb 
des Bereichs von 400 Stunden Betriebszeit. Sofern dieses Problem auftritt, 
wenden Sie sich bitte an den Kundendienst und führen eine Reinigung nach 
den Anweisungen durch, die Sie dort erhalten. 
 

 

 

 

 

 

 

 

 

 

 

 



DE   AT   CH   BE
Bei Fragen zum Produkt und eventuellen 
Reklamationen nehmen Sie bitte zunächst mit 
dem Service-Center Kontakt auf, vorzugsweise 
per E-Mail. 

E-Mail:	 service@bresser.de
Telefon*:	 +49 28 72 80 74 210

BRESSER GmbH
Kundenservice
Gutenbergstr. 2
46414 Rhede
Deutschland
*Lokale Rufnummer in Deutschland (Die Höhe der Gebühren je 
Telefonat ist abhängig vom Tarif Ihres Telefonanbieters); Anrufe aus 
dem Ausland sind mit höheren Kosten verbunden.

GB   IE
Please contact the service centre first for any 
questions regarding the product or claims, 
preferably by e-mail.

E-Mail:		  service@bresseruk.com 
Telephone*:	 +44 1342 837 098

BRESSER UK Ltd. 
Suite 3G, Eden House 
Enterprise Way 
Edenbridge, Kent TN8 6HF 
United Kingdom
*Number charged at local rates in the UK (the amount you will 
be charged per phone call will depend on the tariff of your phone 
provider); calls from abroad will involve higher costs.

FR   BE
Si vous avez des questions concernant ce produit 
ou en cas de réclamations, veuillez prendre 
contact avec notre centre de services (de 
préférence via e-mail).

E-Mail:		  sav@bresser.fr 
Téléphone*:	 00 800 6343 7000

BRESSER France SARL 
Pôle d’Activités de Nicopolis 
314 Avenue des Chênes Verts 
83170 Brignoles 
France
*Prix d'un appel local depuis la France ou Belgique

NL   BE
Als u met betrekking tot het product vragen 
of eventuele klachten heeft kunt u contact 
opnemen met het service centrum (bij voorkeur 
per e-mail). 

E-Mail:	 info@bresserbenelux.nl 
Telefoon*:	 +31 528 23 24 76

BRESSER Benelux 
Smirnoffstraat 8 
7903 AX  Hoogeveen 
The Netherlands
*Het telefoonnummer wordt in het Nederland tegen lokaal tarief 
in rekening gebracht. Het bedrag dat u per gesprek in rekening 
gebracht zal worden, is afhankelijk van het tarief van uw telefoon 
provider; gesprekken vanuit het buitenland zullen hogere kosten met 
zich meebrengen.

ES   IT   PT
Si desea formular alguna pregunta sobre el 
producto o alguna eventual reclamación, le 
rogamos que se ponga en contacto con el centro 
de servicio técnico (de preferencia por e-mail).  

E-Mail:	 servicio.iberia@bresser-iberia.es 
Teléfono*:	 +34 91 67972 69

BRESSER Iberia SLU 
c/Valdemorillo,1 Nave B 
P.I. Ventorro del Cano 
28925  Alcorcón Madrid 
España
*Número local de España (el importe de cada llamada telefónica 
dependen de las tarifas de los distribuidores); Las llamadas des del 
extranjero están ligadas a costes suplementarios..

Service



Bresser GmbH
Gutenbergstraße 2
46414 Rhede · Germany
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